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1 Welcome

The Telescience Resource Kit (TReK) is a suite of software applications and libraries that
can be used to monitor and control assets in space or on the ground. The TReK
Command application provides the capability to update, send, and track commands.
Includes support for various types of command destinations.

This tutorial provides step-by-step instructions describing how to perform common
application functions.

This tutorial uses screen dumps taken on a Windows computer. However, the steps are
the same regardless of whether you are running on Windows or Linux.

2 Technical Support

If you are having trouble installing the TReK software or using any of the TReK
software, please contact us for technical assistance:

E-Mail: trek.help@nasa.gov

Messages sent to this address are automatically forwarded to the TReK team.

3 Introduction

The TReK Command application provides the capability to update, send, and track
commands. The destinations available to the application vary based on the installed
version.

4 Overview of the User Interface

4.1 Main Window

The main window contains several areas as shown in Figure 1. The Command Track and
Message Area are dock windows that you can float or dock. To float a dock window, use
your left mouse button to click and hold the title area while dragging the window to
another area of the screen. To dock, use the title bar to drag the dock window over the
main window and drop.
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| TReK Command -- Untitled

File View Command Options Help

Configuration: . Configure | Operational . Activate Deactivate

Commands Command Sequences

Command Complete Alias  Description

Command Sequence Transactions g X

IDV Mame Status Command # Time Start Time End

Command Track g X

Command Uplink Time

Message Area g X

GMT 2024-12-04 153:42:16:401 Info: TReK Command is configured for automation. (automation_config.cpp:1577)

Ready

Figure 1 Main Window

Toolbar
The toolbar at the top of the window provides quick access to configure the application
and activate and deactivate the command service.

Command

The Command area will display a list of commands and command sequences when the
command service is activated. It will also display convenience buttons to perform
functions such as updating a command, sending a command, or starting a command
sequence.

Command Sequence Transactions

The Command Sequence Transactions area displays instances of command sequences as
they are executed and potentially allows a user to stop a long running sequence if
necessary.

Command Track
The Command Track area displays the history of commands sent.

Message Area
The Message Area displays important status and error messages. The message area can

be cleared using the View menu.
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4.2 Toolbar

The toolbar provides visual information about the state of the application and provides
access to common application functions.

Configuration Status

When the Configuration status is black, this indicates the application has not been
configured. When the Configuration status is green, this indicates the application has
been configured and the command service can be activated.

Use the Configure button to access the Configure dialog to configure the application.

Operational Status

When the Operational status is black, this indicates the command service is inactive.
When the Operational status is green, this indicates the command service is active and
tasks such as sending a command or starting a command sequence can occur. The
application must be properly configured before the Activate button will be available. The
command service must be active before the Deactivate button will be available.

Use the Activate button to activate the command service. This will initiate all internal
activities needed to support commanding tasks. When you activate the command service,
you will see activation status messages in the main window message area. If you need to
reconfigure the command application, deactivate the command service, and then push the
Configure button to reconfigure.

4.3 Menus

The Command application menus are: File, View, Command, Options, and Help. Each
of these menus is described in more detail below.

File Menu
The File menu provides the capability to manage configurations and exit the application.

View Menu
The View menu provides the capability to clear the main window message area and show
and hide different areas in the main window.

Command Menu

The Command menu provides the capability to configure the application, activate and
deactivate the command service. It also provides access to functions such as updating a
command, sending a command, viewing command communication messages, viewing
command track information, and clearing the Command Sequence Transactions. The
Command menu is context and version sensitive and items displayed may vary by
version and Command Destination Type.
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As shown in Figure 2, additional menu items are displayed when the Command
Destination Type is a POIC destination.

Command = Options  Help

Configure...
Activate
Deactivate

Send Command

Initiate Command

Update Cormmand...

Update POIC Command...
View Command Communication Messages

Show Command Track

Clear Command Track

POIC Connection Acknowledgment
POIC Command System Cenfiguration
POIC Command Systern Status

Figure 2 Command Menu

Options Menu
The Options menu provides access to the Messages dialog, the Command Preferences

dialog, and the Advanced Settings dialog. The Messages dialog displays application
messages. The Command Preferences dialog provides the capability to configure
preferences such as the Command Confirmation Prompt. The Advanced Settings dialog
provides access to advanced settings.

Help Menu
The Help menu provides access to on-line help and application version information.

5 TReK Command Tour

Sometimes it’s easier to learn how to use an application by example. This tutorial
describes how to configure the Command service, activate the Command service, update
a command, and then send a command.

This section was written assuming you have read the Introduction section and the Main
Window section. If you have not read these sections, please go back and read them.
They contain important information that is not repeated in this section.
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If at any time you need to exit the application so you can resume working through the
Tutorial at a later time, File Save will allow you to save all the data you entered.

Please go through the tour in order. Some sections depend on data from previous
sections.
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Step-By-Step

1. If you haven’t started the Command Application, use the operating system’s menu to
start the application. You should see the Command main window shown in Figure 3.

| TReK Command -- Untitled

File View Command Options Help

Configuration: . Configure | Operational . Activate Deactivate

Commands Command Sequences

Command Complete Alias  Description

Command Sequence Transactions g X

IDV Mame Status Command # Time Start Time End

Stop
Command Track g X
Command Uplink Time
Message Area g X

GMT 2024-12-04 15:42:16:401 Info: TReK Command is configured for automation, (automation_config.cpp1577)

Ready

Figure 3 TReK Command Main Window

2. Push the Configure button in the Main Window Toolbar. You should see the
Command Configuration dialog shown in Figure 4. Note: the default state of the
dialog may vary based on version.
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v Command Configuration

General Commands Command Sequences History Bridge

Destination Mame:

Destination Type: |[UFD e

Comrunication Type: |UDP A

General Firewall (MAT)

Local Information

Local IP Address: | 10.232.81.236 | | Browse...

Local Port: |a500 |

Destination Information

i) Host Name:

(®) IP Address: | |

Port: |5150 |

Corcel

Figure 4 Command Configuration Dialog (General Tab)

3. On the General Tab change the Destination Type to UFO, if not already the default.
The dialog should look like the one shown in Figure 5.
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Comrand Configuration

L.

General Commarnids Command Sequences History Bridge

Destination Mame:

Destination Type: |UFD B

Cormunication Type: |UDP b

General Firewall (MAT)

Local Information

Local IP Address: |10.232.51.236 | | Browse...

Local Port: |a500 |

Destination Information

i) Host Mame:

(®) IP Address: | |

Part: 5150 |

Corcel

Figure 5 Command Configuration with UFO Destination Type Selected

4. On the General tab enter the following information:

Destination Name: UFO
Destination Type: UFO
Local IP Address: Enter your local IP address.
Local Port: 8500
Destination IP Address: Enter your local IP address
Destination Port: 8888

Your dialog should now look like the one shown in Figure 6.
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‘| Command Configuration

General Commands Command Sequences History Bridge

Destination Mame: |UFO

Destination Type: |UFO w

Communication Type: |UDP e

General Firewall (MAT)

Local Information

Local IP Address:  |10.232.81.236 || Browse...

Local Port: |a500 |

Destination Information

O Host Mame:

@ 1P Address: | 10,232.81.236 |

Port: |azag] |

Cancel

Figure 6 Command Configuration with General Tab Populated

5. In the Command Configuration dialog, select the Command tab. Your dialog should
look like the one shown in Figure 7.
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‘| Command Configuration

General Commands Command Sequences History Bridge
Command N Browse Database...
Browse Disk. ..
Delete
Cancel

Figure 7 Command Configuration Dialog (Command Tab)

6. Push the Browse Disk button. The open dialog will default to the
trek_workspace/metadata/command_packet directory as shown in Figure 8.

10
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B3 Open *
" » mps » trek_workspace » metadata » command_packet v Search command_packet 2
Organise v New folder ==~ O @
~ MName Date modified Type Size
3+ Quick access B
I Deskt » [ acceleratexml 1 XML Document 23KB
eskto -
P [ big_mod_cmd.xml 1 XML Document 15KB
* Downloads * |j camera_modexml 1 XML Document 19KB
£ Documents #* |j directory_request.xml 1/, XML Document 19 KB
=| Pictures * [ load_parameter.xml 1 XML Document 27KB
Release - |j mazx_ternp.xml 1 XML Document 27 KB
bin g power_offxml 1/, XML Document 21 KB
command tutorial |7 test_switchxml 1 XML Document 27T KB
p - |j var_command.xml 1 XML Document 16 KB
oc
doc
¢@ OneDrive
. v
File name: || v| Metadata File(s) () v

Figure 8 Command Metadata Files

7. Select the file named test_switch.xml and push the Open button. The command will
be added to the Command list as shown in Figure 9.

11
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‘| Command Configuration

General Commands Command Sequences History Bridge
Command - Browse Database. ..
TEST_SWITCH
- Browse Disk. ..
Delete
OK Cancel

Figure 9 Command Configuration Command List with TEST_SWITCH Command

8. Push the OK button to complete the configuration. You should see the Configuration
status has turned green as shown in Figure 10.

12
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| TReK Command -- Untitled

File View Command Options Help

Configuration: . Configure | Operational . Activate Deactivate

Commands Command Sequences

Command Complete Alias  Description

Update Send
Command Sequence Transactions g X
IDV MName Status Command # Time Start  Time End
Stop
Command Track g X
Command Uplink Time
Message Area g X

GMT 2024-12-04 15:42:16:407 Info: TReK Command is configured for automation. (automation_config.cpp:1377)

Configured, please Activate to use Command service.

Figure 10 Main Window showing Configuration Status Green

9. Push the Activate button in the Main Window toolbar to activate the Command
service. Once the service is active you should see the Operational status turn green as
shown in Figure 11.

13
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| TReK Command -- Untitled

File View Command Options Help

Configuration: . Configure | Operational . Activate Deactivate

Commands Command Sequences

Command Complete Alias Description
TEST_SWITCH Yes TEST_SWITCH Test switch.
Update Send
Command Sequence Transactions g X

IDV Mame Status Command # Time Start Time End

Stop
Command Track g X
Command Uplink Time
Message Area g X

GMT 2024-12-04 15:42:16:401 Info: TReK Command is configured for autormation. (automation_config.cpp:1377)
GMT 2024-12-04 16:31:58:853 Info: Successfully activated support for Commanding.

Command Active

Figure 11 Active Command Service

Now that the Command service is activated, the Command list has been populated with
the command you entered in the Command Configuration. You can also see whether the
command is complete (all the command fields have values). There are buttons available
to update and send the command. These buttons will not be active until you select a
command in the list.

10. In the Main Window Command tab, in the Command list select the TEST_SWITCH
command. The Update and Send buttons should now be enabled.

11. Push the Update button to display the Update Command dialog shown in Figure 12.

14
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| Update TEST_SWITCH

Mame: TEST_SWITCH
Mame Start Bit Data Type Data Format Length Medifiable Value &

éCcsds‘u‘ersiDn 'I]I Unsigned Integer  Decimal 3 false 0

CesdsType 3 Unsigned Integer  Decimal 1 false 1

CesdsSecHdrFlag 4 Unsigned Integer  Decimal 1 false 1

APID 5 Unsigned Integer  Decimal 1 false 3

CesdsSeqFlags 16 Unsigned Integer  Decimal 2 false 3

CesdsSeqCnt 18 Unsigned Integer  Decimal 14 true 0

CesdsLength 32 Unsigned Integer  Decimal 16 true 0

CesdsTimeStamp 43 155 Time DateTime 40 true 1970-01-07 00:00:00

CesdsTimeld 88 Unsigned Integer  Decimal 2 false 0

CesdsCheckwordlndicator 90 Unsigned Integer  Decimal 1 false 1

CesdsZoe N Unsigned Integer  Decimal 1 false 0 bl

Cancel

Figure 12 Update Command Dialog for TEST_SWITCH

12. In the Update dialog, scroll down until you see the command field named WORDO05
as shown in Figure 13. Change the value from 0 to 13. It should look like Figure 14.

WORDOS £4 Twos Complement  Decimal 16 true 0.000000

Figure 13 WORDO05 Command Field

15
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| Update TEST_SWITCH

Mame: TEST_SWITCH

Mame Start Bit Data Type Data Format Length Medifiable Value &
WORDO2 16 Unsigned Integer  Decimal 16 false 0
WORDO3 32 Unsigned Integer  Decimal 16 false 3
WORDO4 43 Unsigned Integer  Decimal 16 false 0
WORDO3 B4 Twos Complement  Decimal 16 true
WORDOE 80 Unsigned Integer  Decimal 16 false 0
WORDOY 96 Unsigned Integer  Decimal 16 false 0
WORDO2 12 Unsigned Integer  Decimal 16 false 0
WORDOS 128 Unsigned Integer  Decimal 16 false 0
WORD10 144 Unsigned Integer  Decimal 16 false 0
WORD11 160 Unsigned Integer  Decimal 16 false 0
WORD12 176 Unsigned Integer  Decimal 16 false 0 v
Cancel

Figure 14 Command Field WORDO5 Value Set to 13

13. Push the OK button to close the Update dialog.

Note: The updates you make will only be available while the Command service is active.
Once you deactivate the command service any updates you made will be gone.

14. Now that you have updated the contents of the TEST_SWITCH command, it’s time
to send the command. Select the TEST_SWITCH command in the Main Window
Command list and then push the Send button. If the Command Confirmation Prompt
setting is enabled a message dialog will prompt you to confirm you want to continue.

You should see the TEST_SWITCH command in the Main Window Command Track
area as shown in Figure 15.

16
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| TReK Command -- Untitled

File View Command Options Help

Configuration: . Configure | Operational . Activate Deactivate

Commands Command Sequences

Command Complete Alias Description
TEST_SWITCH Yes TEST_SWITCH Test switch.

Update Send

Command Sequence Transactions g X

IDV Mame Status Command # Time Start  Time End

Command Track g X

Command Uplink Time
TEST_SWITCH 2024-12-04 16:53:37

Message Area g X

GMT 2024-12-04 15:42:16:401 Info: TReK Command is configured for automation. (auternation_config.cpp:1577)
GMT 2024-12-04 16:31:5%:833 Info: Successfully activated support for Commanding.

GMT 2024-12-04 16:33:0%:366 Info: The command update information was succesfully stored for TEST_SWITCH.
GMT 2024-12-04 16:33:37:898 Info: Successfully sent request to send command TEST_SWITCH.

Command Active

Figure 15 Command Track showing TEST_SWITCH Command

That’s it! Now you know how to configure the Command service, activate the command
service, update a command, and send a command. For information about defining
command packets, please reference the TReK Concepts Tutorial, the TReK Metadata
Tutorial, and the TReK Metadata User Guide. For more information about the TReK
Command application please see the TReK Command User Guide.
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